



Submit Search


Upload
pdfcoffee.com_i-openwells-basics-training-3-pdf-free.pdf
•
0 likes•57 views
AI-enhanced description


Jalal NeshatFollow
This document provides an introduction and overview to the Landmark OpenWells software. It outlines the objectives of the OpenWells Basics training course, describes key concepts and terminology used in OpenWells such as the Engineer's Desktop, EDM database, and data migration. It also provides an overview of the system's capabilities including customization, integration, value of data, security, modernization, and ease of use. Finally, it begins describing how to get started with OpenWells, including logging in and entering different types of data.Read less
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Chapter
Introduction
Landmark's latest Drilling and Well Services operations reporting application, OpenWells, is a
fully integrated and comprehensive corporate data management system; including communica-
tions, analysis and engineering information.
OpenWells supports reporting of drilling, completions, and well services operations within a sin-
gle application. It supports multiple systems of measurement, dynamic depth reference elevations,
is extremely customizable, and can be easily configured to support multiple languages. Integrated
workflows with other EDM applications provide solutions that span the life of a well from initial
planning, drilling, completions, production to field abandonment.
OpenWells Overview
Wellsite Operations reporting offers a new look and feel by taking
advantage of the flexibility of a highly customizable application and
Landmark's Engineers Database Model (EDM) to provide integration
between Landmark Drilling, Well Services, and Production products.
OpenWells shares a common database platform with CasingSeat,
StressCheck, COMPASS, and WELLPLAN. All products also have
consistent Data Management, Navigation, Security, Data
Synchronization, Unit Management, and Depth Reference Elevation
Systems. Consistent user interface components and methods have been
implemented wherever possible between all EDM applications to
provide the user with a consistent experience across applications.
OpenWells Basics Course Objectives
After completing the OpenWells Basic course you will be able to:
• Label the basic components of the OpenWells main screen.
• Navigate the OpenWells main screen in order to locate specific
data.
• Describe the relationship between OpenWells and the Engineer’s
Desktop.
• Summarize the function of Unit Systems and Datums in
OpenWells.
• Describe the use of Tight Groups in OpenWells.
1
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• Construct a full data set for the Drilling Tab of the Well Explorer
(Database, Company, Project, Site, Well, Wellbore, and Event).
• Construct a partial data set for the Contractors Tab of the Well
Explorer (Contractor, Rig, Rig Operation, Pump, and Shaker).
• Label the basic components of the Data Entry Form in OpenWells.
• Demonstrate the proper use of all data entry types.
• Create a new report using the OpenWells Report Wizard.
• Enter data into the following data entry forms: AFE and Cost
Estimate, Daily Operations, Pipe Tally, Casing, and Cementing.
• Demonstrate the process for previewing and saving Output Reports.
• Use the appropriate tools to import data to OpenWells.
• Use the appropriate tools to export data from OpenWells.
• Send a Report to the office using the Field Office Data Transfer
application.
The Origins of OpenWells
OpenWells has been developed to replace Landmark Graphics
Corporation’s DIMS (Drilling Information Management System)
application.
DIMS is still the most widely used drilling and well services operations
reporting system in the industry. Introduced in the mid 1980’s, the
original DIMS application was created to allow the morning daily
drilling reports to be entered at remote, Canadian rig sites, transmitted
into the office using a 1200 baud modem, and printed on dot matrix
printers in the Drilling Department. DIMS grew into a complete office
to well-site operations, reporting, analysis, and database management
system which could be configured to adapt to any operating
environment. The technological environment has grown and changed.
Slow baud rates have been replaced with ultra-fast modems, satellite
supported, and wide area networks. The trickle of operations data from
the field has become a wide, bi-directional flow, linking field and office
together.
Despite the advances in hardware technology there exists a need in the
oil and gas industry to capture, report, review, analyze, and optimize
Well operations for cost efficiency as well as worker, public, and
environmental safety. These needs existed when DIMS was created.
They existed over the years when DIMS served our clients as a valuable
tool. They still exist and have become even more complex in today’s
marketplace where demand for increased performance and cost
efficiency contained by a decreasing sized workspace requires
knowledge and understanding to be captured and widely accessible in
Well engineering software systems.
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Individual sets of isolated well information have accumulated into vast
pools of knowledge that have become true corporate assets. Allowing
this information to be available across a company whenever it is needed
and by whatever application needs it, are challenges that can be
answered by OpenWells and the Engineer’s Desktop.
About This Manual
This training manual complements the instruction provided in the
OpenWells Basics training course.
Each section of this manual corresponds to a section completed in the
course and can be used both during and after the course to answer
questions that you may have about OpenWells.
System Overview
OpenWells is designed to provide drilling, completions, well servicing,
and operations reporting information within a single application.
OpenWells is a fully customizable application that can be configured to
meet the specific needs of a company.
OpenWells is built around the following key themes: customization,
integration, value of data, security, modernization, and ease of use.
Customization
The customization features in OpenWells allow the user to configure
elements such as the data entry forms, output reports, preview panes,
and shortcut bars.
OpenWells also includes full internationalization support. This means
that by changing the Windows Regional Settings, OpenWells can be
launched in another language.
Integration
The integration of drilling engineering workflows through the
Engineer’s Desktop provides improved data integrity across
applications. As more versions of OpenWells are released, Landmark is
continuing to develop more efficient workflows for various groups of
users including Well Services Engineers, Drilling (field) users, Wellsite
Geologists, Office Well Planners, and Management.
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Value of Data
OpenWells offers improved graphic visualization of data through
features such as customizable data previews and thoughtfully developed
output reports. The 2003.11 release of EDM will also include Data
Analyzer, PROFILE, and iWellFile (based on iDIMS).
Security
Security is extremely important for the protection of client data. In
OpenWells there are two types of security; application security and
database security.
In the OpenWells application, security is enabled through the
assignment of security levels to fields and users and through the use of
tokens. Security levels are given to fields within the application. Users
are also given a security level. If the users’ security level is greater than
or equal to that of the field, the user can access the field contents. Tokens
are also used to provide or revoke access to specific functionality in the
application. The ability to edit, add, or delete within the application is
based on tokens.
Modernization
The 2003.5 version of EDM provides a set of tools to help clients move
DIMS data into OpenWells using a complete and comprehensive data
migration.
Ease of Use
OpenWells offers an improved user interface the implementation of a
three paned navigational window. This application has been designed
with interfaces common to the suite of Landmark engineering
application whenever possible. While in the design phase, client
feedback was incorporated into the design of the Data Entry Forms.
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OpenWells Concepts and Terminology
Engineer’s Desktop
The Engineer’s Desktop is built on a robust integrated infrastructure
known as the Engineer’s Data Model. The Engineer's Data Model
(EDM) is Landmark’s Drilling, Well Services, Production, and
Economics integration platform. EDM provides a common database
schema that allows for common data access, enables naturally integrated
engineering workflows, and reduces data entry duplication across
applications.
The EDM database improves integration between Landmark's Drilling
and Well Services products by enabling OpenWells to use and share the
same data set with other engineering applications.
Release 2003.11 Engineering applications include:
CasingSeat - Casing shoe size and depth selection,
StressCheck - Casing Design,
COMPASS - directional well planning, survey management and anti-
collision risk assessment,
WELLPLAN - Torque/Drag, Stuck Pipe, BHA Drill Ahead analysis,
Critical Speed string vibration analysis, Swab-Surge, Hydraulics,
Cementing, Well Control, and Engineering Notebook,
OpenWells - comprehensive wellsite operations reporting,
communications, analysis and engineering information in a corporate
data management system used to capture data for drilling and well
services operations.
PROFILE - data driven wellbore equipment schematic diagrams
allowing the visualization of currently installed and historical wellbore
information and downhole equipment; allows for quick entry of
wellbore equipment and downhole equipment.
EDM Engineering applications share many User Interface components
including:
• Well Explorer for consistent Data Management and Navigation
• Audit Information
• Reference Datum Levels (RDL)
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• Unit System Editor
• Unit System Management
• Simultaneous Activity Monitor (Multi-User Support)
• Output Reporting Engine
• Security
• Data Locking
• Unit System Management
• Field Office Data Transfer
• Catalogs
EDM Database
OpenWells, COMPASS, StressCheck, WELLPLAN, CasingSeat and
PROFILE using the EDM Database
The EDM database is a mix of common data tables, common
infrastructure tables, and application specific tables. The common data
tables allow the applications to naturally integrate through sharing of a
single data hierarchy and common data such as assemblies and
formation tops. Data required in a specific application is stored within
dedicated application data tables.
All applications communicate with the EDM database through data
handler layers. Most commonly, the EDM Data Services toolkit
developed by Landmark is used. Data Services handles all of the select,
insert, update, and delete transactions required by the application and
also provides for Import and Export of data transfer files using XML as
the data definition language.
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Data Migration
The Data Migration Toolkit is included with Release 2003.5. The Data
Migration Toolkit allows companies to migrate COMPASS,
WELLPLAN, and DIMS data sets to EDM. Common data from
COMPASS, WELLPLAN, and DIMS databases can then be merged
into EDM to create one set of shared business objects, preventing future
duplication of information.
Map - Migrate - Merge
The migration of data from legacy Landmark Drilling and Well
Services databases to the EDM database is critical to the integrity of the
resultant EDM data set that is created from the migration process.
DIMS, COMPASS, and WELLPLAN data is handled by the Data
Migration Toolkit. StressCheck and CasingSeat data can be imported
within those applications when running against the EDM database. The
migration of legacy DIMS, COMPASS, and WELLPLAN data to the
EDM database is a three-step process:
• Mapping of fields,
• Migration of data, and
• Merging of data.
The Data Migration Process
The Data Migration Toolkit has been developed for each of the three
steps in the data migration process to enable clients to migrate DIMS,
COMPASS, and WELLPLAN databases to the EDM database. This
toolkit contains the following three tools:
• Field Mapping Tool
• Data Migration Tool
• Data Merging Tool
Map Migrate Merge
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Unit Systems
OpenWells is shipped with two default unit systems:
API (American Petroleum Institute)
This unit system in based on the Imperial system of measurements
(i.e., Feet (ft), Inches (in), Pounds (lb), Quart (qt), Gallon (gal)
Fahrenheit (°F)).
API - US Survey Feet (American Petroleum Institute)
This unit system in based on the API system described above. It has
the ability to display units in fractions.
SI (International System of Units)
This unit system is based on the Metric system of measurements, its
units are identical in all languages (Meters (m), Centimeters (cm),
Millimeters (mm), Kilograms (kg), Liters (L) Celsius (°C)).
The Engineer’s Desktop also allows for the creation of a customized unit
system based on either one of the above systems.
For more information on Unit Systems, see “Unit System” on page 3-20.
SAM - Simultaneous Activity Monitor
The 2003.5 release of the Engineer's Data Model supports full
concurrency for multiple applications accessing the same data set
through the Simultaneous Activity Monitor (SAM). The Simultaneous
Activity Monitor consists of a Messaging Server. This service notifies a
user of all data items currently open by other applications sharing the
same database. SAM does not indicate what its own application is doing,
it is merely a messenger service that monitors other applications which
share an EDM database.
For more information on SAM, see “SAM - Simultaneous Activity
Monitor” on page 3-78.
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Security in OpenWells
Security in OpenWells is based on user authentication and validation,
user/group management, and application security.The OpenWells
System Administration course and manual covers all aspects of
managing security in OpenWells.
Data Locking can help secure data in your OpenWells database. For
more information on Data Locking, see “Data Locking” on page 3-23.
Tight Groups
Tight Groups are used to restrict access to the Site and Well levels of the
Well Explorer hierarchy. Each Site and Well is associated to a particular
Tight Group. Sites and Wells to which the User or their Group does not
have Tight Group access are not displayed. This security measure
effectively prevents the user from accessing this data. For a restricted
Site, all Wells, Wellbores, Events, and Reports within that Site are
hidden. For restricted Wells, all Wellbores, Events, and Reports are
hidden. Tight Group creation and membership can be managed by your
System Administrator using the EDM Administration Utility.
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Chapter
Getting Started
In this chapter you will learn how to:
• Log in to OpenWells.
• Demonstrate the proper use of all data entry types.
OpenWells and the Database
The common database schema allows for common data access. This
means that one set of data can be accessed from several different
applications. For example:
OpenWells and COMPASS application accessing the Grizzly Well
from the EDM database
The database also enables naturally integrated workflows. The
directional well planning of a trajectory for a Well can take place in
other applications (such as COMPASS) and then used in OpenWells to
compare the Drilling progress against plan.
Finally, the common database reduces duplication of data entered
between applications. Some of the same data that is required for Well
planning in COMPASS is also required in OpenWells. If the data, such
as a survey, is entered in COMPASS and stored in the EDM database, it
will not have to be re-entered in OpenWells.
Grizzly Well
2
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The following icon is used in the OpenWells Well Explorer to represent
the Database.
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Log Into OpenWells
To log into OpenWells, double-click on the OpenWells icon on your
desktop.
Alternatively, to open the OpenWells application follow the menu path:
Start > Programs > Landmark EDM > OpenWells
The OpenWells product screen appears and then the following login
screen appears:
OpenWells login screen
Use the dropdown picklist to select the EDM Data Source.
Enter your User name and Password.
Note:
If you are uncertain about the Data Source to be used, contact your System
Administrator.
Note:
If you are uncertain about your User name or Password, contact your System
Administrator.
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The next time that OpenWells is launched, the data source most recently
used is remembered. OpenWells also flags valid EDM data sources that
have been used previously with a database icon. (See the OpenWells
login screen on the previous page.)
The OpenWells main screen appears. For more information on the main
screen and its components, see “OpenWells Main Screen” on page 3-1.
Other EDM applications may then be launched without requiring the
user to login as the initial login is shared.
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Data Entry Types
Simple Data
Simple Data Fields or text fields are fields that require a keyboard entry
that corresponds to the field title. Some Simple Data Fields will only
accept specific data in specific formats (e.g. telephone numbers, time).
This means that the field has been set to accept a certain type of value
such as ten digits for a phone number.
To navigate between simple data fields:
• Press Tab to move forward (to the right or down) from one field
to the next.
• Use the mouse to position the cursor in the field and click the left
mouse button once.
• Press Shift + Tab to move backward (to the left or up) one field.
Picklist
Picklists are dropdown selection lists designed to simplify and expedite
data entry and ensure data integrity and consistency by providing a
selection of valid entries to complete a field.
A picklist is accessed through a dropdown arrow ( ).
Select the dropdown picklist to display a predefined list of valid values
for the field. Alternatively, press the F4 keyboard shortcut to display the
list.
Picklist contents may be edited, using the Picklist Editor, by your
System Administrator or users with a sufficient security level.
Validated and Optional Dropdown Picklists
There are two types of picklists available in OpenWells. The validated
picklist and the optional picklist.
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Validated Picklists
A validated picklist will only allow the user to select a value from the
picklist. If an item that is needed is not found in the picklist the System
Administrator must be contacted to add it to the picklist.
Optional Picklists
An optional picklist is one that will allow the user to enter a value into
the field if they do not find the appropriate item in the picklist.
There is no visual indicator to differentiate a validated picklist from an
optional picklist though it becomes evident if a user tries to enter a value
using their keyboard into a field with a validated picklist.
Spreadsheets and Tables
Spreadsheets and Tables are an integral part of OpenWells. They are the
ideal way to present a number of information types that OpenWells
captures.
A spreadsheet is a collection of individual data fields (cells) that are
arranged in rows and columns. Spreadsheets allow the user to edit data
within a cell and see the change immediately.
Tables are similar to spreadsheets in their layout but unlike
spreadsheets, tables are used to display information and their cells
cannot be edited directly. The data found in a table comes from various
locations in the application. Changing data in a table involves changing
the source field for the data.
An advantage of spreadsheets and tables is their ability to collect and
display a large amount of data in a small space.
Spreadsheets and some tables can be expanded both vertically and
horizontally. When the size of a spreadsheet or table exceeds the size of
its display area scroll bars will appear allowing the user to navigate
through the entire spreadsheet.
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Spreadsheets and Tables in OpenWells, terms and definitions
Spreadsheet and Table Data Entry Features
Column Headings
Spreadsheets have column headings similar to tables. They hold a
descriptive title to clarify the data currently displayed or the data to be
entered in the column. Columns with a unit class, such as feet, assigned
will display the unit label, ft, in parenthesis after the column name.
Spreadsheet columns also allow for width manipulation, sorting, and re-
arrangement.
• Widths can be manipulated to fit the widest text entry in any cell
of the column. To change the column width move the cursor to
the dividing line between the headers until a double headed
arrow appears. Click and drag the column to the required width.
Term Definition
Spreadsheet A number of cells organized in rows and
columns that will either accept the entry of
data or display data entered in another area of
the application.
Basic Table The basic table is for display purposes only
and can be found in the following areas of the
OpenWells applications; Report List (in the
main application window), Associated Data
Viewer, and Wizards.
Multi-Level
Spreadsheets and
Tables
A spreadsheet within a spreadsheet/table; if
an associated child row, or sub-spreadsheet is
present an indicator ( ) appears in front of
the parent (main) row.
Detail
Spreadsheets and
Tables
Detail spreadsheets and tables in OpenWells
enable more efficient data viewing. The data
within a row of the table is entered through
fields appearing below the spreadsheet/table.
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• Columns can be sorted by clicking on the Column Heading for
the column you want to sort by. Click once to sort ascending and
click again to sort descending. An arrow is displayed on the
column header to indicate whether the column is sorted in
ascending or descending order.
• Column order can be changed using the drag and drop feature.
Click on the column, holding the mouse button down and drag
the column to the new location.
Function Buttons
At least two function buttons are always associated with a spreadsheet.
Spreadsheet function buttons
There are additional function buttons associated with some spreadsheets
Note:
OpenWells will remember any adjustments made to the width and position of
the columns within a Spreadsheet. This only works for Spreadsheets on Data
Entry Forms. The adjustments are saved to an XML file in the user’s settings
folder. (x:Documents and
Settings<user>ApplicationDataLandmarkOpenWells
UserPreferences.xml). The adjustments are saved when the user leaves a form
by closing the window, switching days, or switching report types - even if the
user doesn’t save the form’s data by clicking Cancel in the ‘Do you want to
save?’ dialog. These user adjustments are ignored if the administrator (using
the EDM Administration Utility) changes the configuration of the section
containing that spreadsheet.
Button Name Function
Add Row Adds a row to the bottom of the
spreadsheet.
Delete Row(s) Deletes the current row in the
spreadsheet. Select multiple rows to
delete several rows of data.
In some spreadsheets only one row
can be deleted at a time. If this is the
case the tooltip will read Delete
Current Row.
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Additional Spreadsheet function buttons
These spreadsheet functions are also available through the right-click
menu.
Picklist Icon
When a picklist icon ( ) is located next to a cell, a picklist is available
for that cell. Picklists may be opened by selecting the picklist icon, or
pressing the F4 key. Not all spreadsheets contain picklists.
Checkboxes
Many spreadsheets contain checkboxes. Checkbox fields have only two
settings: they are either activated or deactivated. When the checkbox is
empty the cell is deactivated, and the function expressed in the column
header is ignored. When the checkbox is populated with a check mark,
the cell is activated and the function expressed in the column header is
carried out for the selected row.
Button Name Function
Insert Row Inserts a row above the selected row
in the spreadsheet.
Add Row to Sub-
Spreadsheet
Adds a sub-spreadsheet row for the
current row.
Move Current Row Up Use this button to move a row up one
position in the spreadsheet.
Move Current Row
Down
Use this button to move a row down
one position in the spreadsheet.
Collapse All Use this button to collapse all sub-
spreadsheets located within a main
spreadsheet.
Expand All Use this button to expand all sub-
spreadsheets located within the main
spreadsheet.
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Date Selectors
Cells in a spreadsheet that require a date contain a picklist icon. When
this icon is selected the Date Selection dialog appears. Using the Date
Selection dialog reduces errors that result from entering dates in the
wrong format.
To enter today's date in a field quickly, select the field and press F12.
To enter the Report date, use the Shift + F12.
Date /Time Selectors
Some Date Selection dialogs also include a field for time entry.
A time can be manually entered in the field or the scroll buttons can be
used to scroll to the correct time.
The time format can be set using either a 24 hour clock or a 12 hour
clock using the Windows Regional Settings on your computer.
Using Spreadsheets and Tables
Spreadsheets contain interactive data fields, which means data can be
entered and edited directly in the cells of the spreadsheet. There are three
fundamental operations for OpenWells spreadsheets: add a row, insert a
row, and delete a row.
Tables do not have interactive data fields. This means that data
appearing in a table originates from elsewhere in the application. Tables
are used to display information in a read-only format. The data found in
a table comes from various locations in the application. Changing data
in a table involves changing the source field for the data. There are four
fundamental operations for OpenWells tables: add a row, insert a row,
delete a row, and populate a row.
To enter new data in a spreadsheet/table a new row must be added to
accept that data.
Note:
Columns cannot be added, inserted, or deleted in spreadsheets/tables. Your
OpenWells System Administrator can configure OpenWells to only show certain
columns. Users may adjust the look and feel of spreadsheets by changing column
order and width. In OpenWells’ data entry forms these changes are remembered
between sessions.
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Adding a Row to a Spreadsheet or Table
While working in the spreadsheet or table, click the Add Row button
( ) to add row to the bottom of the spreadsheet.
The Insert and Delete buttons are greyed out until the first row is added
to the spreadsheet/table.
Inserting a Row
To insert a row between two existing rows, highlight the row that will
appear below the new row by clicking on any cell in the row, then click
the Insert Row button ( ).
Deleting a Row or Rows
While working in the spreadsheet/table, select the row(s) to delete by
clicking on the row heading number, then click the Delete Row button
( ). The entire row must be selected to use the delete function.
To delete more than one row, hold down the Shift key and select the
rows. When all rows to be deleted are highlighted, click the Delete Row
button.
Adding a Sub-Spreadsheet Row
While working in a parent (main) row in a Multi-level Spreadsheet/
Table, click the Add Row to Sub-Spreadsheet button ( ). This will
associate the Sub-Spreadsheet with the current row selected in the main
spreadsheet.
Note:
A multi-level spreadsheet is located in the Bulks section of the Daily Operations
report.
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Deleting a Sub-Spreadsheet Row
Select the sub-spreadsheet row to delete by clicking on any cell in the
row, then click the Delete Row(s) button ( ).
Frozen Columns in Spreadsheets and Tables
A frozen column in a spreadsheet/table is a column which remains fixed
when scrolling horizontally through the spreadsheet or table. All
columns to the left of this column will also remain fixed. Frozen
columns are configured by your System Administrator.
Populating Cells in a Spreadsheet
Cells in a spreadsheet row can be populated in a number of ways:
• Select the cell and enter the information through the keyboard.
• Select the picklist icon to the right of the cell ( ) or press the
F4 key.
• To enter a date and/or time, use the picklist located to the right
of the cell to access the date selector. Press the F12 key to enter
the current date in a date only field. Press the F12 key to enter
the current date and current time in a date/time field.
• To enter the current Report date, press Shift + F12.
To move from cell to cell in the spreadsheet the following keyboard
options are available.
Keyboard options available in Spreadsheets
Note:
When deleting a parent row any sub-spreadsheet row or rows will also be deleted.
Keyboard Key Use
Tab Use the Tab key to move the cursor across a
spreadsheet row, left to right, one cell at a
time.
Shift + Tab Use this keyboard combination to move
across a spreadsheet row backwards from
right to left, one cell at a time.
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Alternatively, the mouse can be used to navigate through the
spreadsheet.
Populating Cells in a Table
To enter new data for a table a new row must be added. Once a row has
been added a number of fields will appear below the table. Each field
that appears corresponds to a column of the table.
To enter data for a table row, select the row and start entering data into
the corresponding fields below.
Date Entries
Date entries in OpenWells can be entered using the date selection
dropdown. This dialog is accessed through a dropdown arrow ( ), that
looks similar to the arrow used to access picklists.
Using the Date Selection dialog reduces errors that result from entering
dates in the wrong format. For example, entering the date in dd/mm/
yyyy format instead of mm/dd/yyyy.
All dates are entered in a short date format to ensure the date can be
stored in any ODBC compliant database without modification. If a date
is entered with the year in a two-character format (dd/mm/yy) an error
is returned. By forcing the date to be entered in the short date format,
OpenWells ensures that the correct date is sent to the database.
Enter Use the Enter key to move the cursor across a
spreadsheet row, left to right, one cell at a
time.
Arrow Use the directional arrow keys on the
keyboard to move in the direction of the
arrow pressed, one cell at a time.
Note:
Columns cannot be added, inserted, or deleted in tables. Your OpenWells System
Administrator can configure OpenWells to only show certain columns.
Keyboard Key Use
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The order of MM, DD, YYYY is taken from the local PC's Regional
Settings short date configuration to ensure that dates can be entered
according to local convention. To change the date format, you must
change it in the Windows Regional Settings.
To enter today's date in a field quickly select the field and press F12.
Time Entries
Time can be manually entered in the data entry field or the scroll buttons
can be used to scroll to the correct time.
The time format can be set using either a 24 hour clock or a 12 hour
clock using the Windows Regional Settings on your computer.
When using a time field, the time is laid out in hours and minutes: 00:00.
Change the value in the hours position by clicking on the hours segment
and scrolling up or down using the arrow buttons to the right of the field.
The minutes and seconds (where available) can be changed in the same
way.
To insert the current time (based on the clock setting in your computer),
press F12.
Time fields within the Daily Operations report will only accept time
ranges that fall within the current Reporting Standard.
Checkboxes
Many Data Entry Forms and dialog boxes in OpenWells contain
checkboxes.
Checkbox fields have only two settings: they are either activated or
deactivated. When the box beside the field title is empty the field is
deactivated, and the function expressed in the field title is ignored.
When the box is filled with a check mark (activated), the field is active
and the function expressed in the field title is carried out.
Note:
When a date is entered manually through the keyboard, do not forget the leading
zeros for days and months where appropriate (for example, enter 02/03/1997, not 2/
3/1997).
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To change the status of a checkbox field, click once on the box with the
mouse.
Catalogs
Catalogs are used to collate a list of available assembly components and
their properties. These catalogs are shared by various EDM applications
as selection lists for various equipment such as Drill Pipes, Drill Collars,
Centralizers, Mud Motors, and Packers. OpenWells has catalog
selection interfaces in the Drillstrings section of the Daily Operations
report, Pipe Tally report, Casing report, and Wellbore Equipment report.
Use the Catalog dropdown to select the appropriate component type.
Catalog window; Select New Section Type
The Catalog field picklist allows the user to select a catalog if there is
more than one catalog available for the section type selected.
Double click to make an initial selection in any one of the columns. This
will narrow down the selections available in the columns below the
Catalog field.
Making the first selection in a Catalog
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Double-click on an item in any one of the columns and the selections
will again be filtered.
Making the second selection in a Catalog
As data is selected in each column the other columns are dynamically
changed to reflect the selections available. Once a selection is made in
all columns the OK button becomes available. Click OK to use the
selection.
All selections made in the Catalog
The Reset button resets all columns in the catalog if the user has made
a mistake.
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Libraries
A Library is a tool employed by OpenWells and WELLPLAN to store
drillstrings or fluid descriptions for future use. Once a drillstring or fluid
is stored in a library, it can be retrieved (imported) to quickly and easily
create a new fluid or drillstring based on the retrieved string or fluid. For
example, a drillstring library can be used to store commonly used
assemblies. Once a drillstring is imported from a library, it can be edited
to meet your current objectives.
A library should not be confused with a catalog. A catalog contains a
collection of similar drillstring components that can be used to build a
drillstring. For example, there are jar catalogs, or drill pipe catalogs. A
library is used to store the complete drillstring, not a certain type of
drillstring component.
You can use the fluid library to store commonly used fluids. Each fluid
entry in the library includes all the data required to define that fluid, such
as rheological model, weight, gel strength, etc. As with drillstring
library entries, once the fluid has been imported from a library into the
current case, it can be edited as desired.
Using WELLPLAN Libraries can be shared with other users by
exporting them at the database level to library transfer files (.LIB xml).
Libraries are accessible in the Daily Operation Report; Drillstrings and
Fluids Sections.
Read Only
Some data fields in the Data Entry Forms may appear as 'greyed-out'
fields. These fields have been populated by data in fields present in other
parts of the form or in other parts of OpenWells, or the user does not
have sufficient security to edit the field. By default read-only fields
cannot be directly edited. If a read-only field needs to be edited, the
entry must be changed in the source fields.
OpenWells read-only fields are shipped with the application, and can
also be configured by your System Administrator.
An example of a read-only field shipped with OpenWells is the Total
Daily Cost field in the General Section of the Cost Estimate and AFE
report.
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Memo
Memo fields are large text fields that allow unlimited free-form text
entry.
Memo fields are unrestricted with respect to content but should be
relevant for the Data Entry Form in which they are entered. Depending
on how the System Administrator has customized your version of
OpenWells, memo fields can also be unrestricted in space. This means
that the user can enter as much information as necessary to describe a
situation.
When using memo fields it is important to remember that other users
will access the information entered. Therefore it should be documented
in a way that will be understandable to others. Avoid the use of
uncommon abbreviations and acronyms where possible.
Carryover
When creating a report for the first time, some data fields in the Data
Entry Form may be populated automatically using default values or data
from the previous report. This auto-populated data is called carryover
data.
Carryover fields are configured in OpenWells by the System
Administrator using the EDM Administration Utility.
Simple examples of carryover fields are DOL (Days on Location) and
DFS (Days from Spud) fields in the Daily Operations report, which
increase incrementally by one in the General section of the second or
subsequent Daily Operations data entry form. Some data is carried over
with no change (e.g., Supervisor Name).
By default most carryover fields can be directly edited unless it has been
configured as a read-only field by the System Administrator.
Spreadsheet Carry Down
In some instances, data entry fields are automatically populated with
information that carries down from a previous row in a spreadsheet. For
example, in a spreadsheet containing From and To depths over time, the
From value for a new row may default to the To value of the previous
row.
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This functionality can be configured by your System Administrator
using the Layout Manager in the EDM Administration Utility.
Entering Data in Different Units
Use the F4 key to access the Convert [Unit Class Name] Units dialog
box. Allows you to enter the data for the active cell in different units
than those configured in the active unit system.
 


	40. Chapter 2: Getting  Started
2-20 OpenWells Basics Training Manual Landmark
The Data Dictionary
The EDM Data Dictionary allows the System Administrators to
customize the Data Entry Forms and Property Pages within OpenWells.
The Data Dictionary is accessed through F7 or the toolbar icon ( )
and is available to authorized users and may be displayed as read-only
for non-authorized users. From within the Data Dictionary a user can
configure picklists and the appearance and availability of data entry
fields.
The Data Dictionary is covered in more detail in the OpenWells System
Administrator course materials.
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Knowledge Management in OpenWells
The Knowledge Management system in OpenWells is designed to
facilitate data, information, and knowledge sharing within a
corporation. EDM and OpenWells support Knowledge Management
initiatives by enabling experienced field hands to document their
experience and insights through a usable interface available to them at
the well site. This enables Operators to easily capture valuable learnings
from the field supervisor's and engineer's least accessible from the
office.
The following processes can be used to improve Well construction and
analysis processes through improved utilization of previously recorded
operations experience and learning.
• Lessons Learned
• Equipment Failure and Non-Productive Time (NPT)
• Technical Limit
Lessons Learned
Lessons Learned is a component of the Knowledge Management system
which allows a company to record operations experience and learnings.
This information, in turn, can be used to improve Well designs and
operations for future Wells. The EDM Lessons Learned system and
information storage area may also be integrated by clients to liaise with
other Knowledge Management systems within their IT infrastructure.
Lesson Property Page
The lessons learned feature provides a number of benefits to the
organization:
• Users in the field who have first hand knowledge and experience
with both processes and equipment used on the Rig can document
their expertise to the rest of the organization. The Lessons Learned
data entry areas in OpenWells enable these users to easily enter this
valuable information.
• Lessons Learned data entry areas provide fields to enter
information for equipment, processes, methods, and vendors.
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• Lessons Learned information can be associated to activity code
information. This information can then be used during the Well
planning phase (using the Well Planning Report) for future Well
designs to improve operations.
• Permutations of lessons information can easily be configured for
comparisons and reporting purposes.
The most valuable lessons are created from (and subsequently linked to)
the following:
• Report data entry window - Lessons can be associated to any
Report type through the Report's data entry forms,
• Equipment Failure/NPT events - Lessons can be added to
Equipment Failures and NPT's (Non-Productive Time's) through
the NPT/Equipment Failure Properties dialog (available in the Time
Summary section of the Daily Operations Report or the Associated
Data Viewer).
Lessons can also be created using the New > Lesson command when the
Well, Wellbore, Event, or Completion node is selected in the Well
Explorer.
Once created, a Lesson is available from the Associated Data Viewer
(see “Associated Data Viewer” on page 3-77).
Equipment Failure and Non-Productive Time
Equipment Failure and Non-Productive Time (NPT) are two
components of the Knowledge Management system which allows a
company to record operations experience and learnings.
Non-Productive Time (NPT) is any deviation from the plan or
unexpected occurrence caused by either equipment failure or an event
such as stuck-pipe or waiting on weather. It is categorized as either lost
time, which is avoidable, or down time, which is unavoidable. Event
functionality provides a mechanism, within the execution phase, to
describe in detail unplanned activities recorded within the operations
time breakdown. Non-Productive events can span either a single activity
or multiple activities. These events can span a single day or cross over
to the next day. For each NPT event, information can be entered related
to equipment failures, cost of the NPT, and descriptions regarding the
Important!
Lessons that are associated with a Report must be created within the Report's data
entry form.
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event and how it was closed-out. NPT is also known as trouble time, and
commonly used as a measure of efficiency for operations.
Equipment Failures and NPT, which delay Well Construction may be
comprehensively documented and associated to Daily Operations
activities. Tracking equipment failures and operation downtime
improves planning for well operations. It also aids in the anticipation of
equipment failures. Using this tracking method facilitates a more
effective and proactive maintenance approach. All of these factors result
in less downtime and greater operations efficiency through modification
of operations with high equipment failure frequencies.
Equipment Failures and Non-Productive Time events are tracked
through the NPT/Equipment Failure Properties dialog ( see “Time
Summary Section” on page 4-15.).
These events are also listed in the Associated Data Viewer (see
“Associated Data Viewer” on page 3-77) whenever the associated Event
is selected in the Well Explorer. Failures are listed by Equipment
System (Date of Failure) and Subsystem.
This unplanned event system enables Daily Operations activities to be
associated to equipment failures and downtime in operations through
the Time Summary section. Within the dialog the engineer is able to
fully define particular activities as Equipment Failure, Equipment
Failure with NPT, or NPT (No Failure). The unplanned event can then
be further defined by equipment system, subsystem location, costs
incurred, and downtime.
Technical Limit
Technical Limit is a component of the OpenWells Knowledge
Management system which allows a company to use existing Well data,
Lessons Learned, Equipment Failure and Non-Productive Time
information to generate a "Best Case Scenario" plan. The goal of this
plan is to reduce well construction and maintenance costs without
compromising safety, the environment, and the well objectives.
Technical Limit is defined as the perfect performance to achieve an
objective limited only by currently available technology and personnel.
The Technical Limit is determined for the well design based on the
operations program. This operations program is generated from the
engineering requirements for the well and capabilities of a specific rig
type and crew. The resultant Technical Limit derived drilling and/or
 


	44. Chapter 2: Getting  Started
2-24 OpenWells Basics Training Manual Landmark
well services program is an aggressive operations schedule which
maximizes the value of the project and meets the agreed objectives.
The Drill Well On Paper (DWOP) prior to spud is part of the well
planning process that is typically part of an operator's Technical Limit
process. It is a key milestone of the Technical Limit planning process.
The key objective is to achieve optimum execution of the well program
by defining an optimum planned operations duration for each activity.
This involves cooperation of the rig crew and service company
personnel. Setting target times creates a ‘base line’ against which actual
execution performance can be measured. Therefore, the target times
(Technical Limit) created are based around execution of the well
program with the actual rig and equipment available.
TL Time = Best time in a Perfect World (TL time)
+ Local Conditions (Rig Type, Rig Equipment, locally available
materials, etc.)
This ‘base line’ plan is then agreed as Target times for the well program
in anticipation that value erosion will occur during well construction.
Performance is then measured against this base line plan during
execution of the well design.
Technical Limit is implemented in OpenWells through the following
areas:
• Well Planning Report, see “Well Planning Report” on page 4-4.
• Planned Operations Section, Well Planning Report (see Well
Planning Report’s online help)
• Offset Wells Section, Well Planning Report (see Well
Planning Report’s online help)
• Daily Operations Report, see “Daily Operations Report” on page 4-
12.
• NPT/Equipment Failure Properties dialog, Time Summary
Section, Daily Operations Report; see “Time Summary
Section” on page 4-15.
• Lessons Learned Properties dialog, see “Associated Data Viewer”
on page 3-77
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OpenWells Online Help
The online electronic help system has been developed to allow for
maximized usage of OpenWells software.
OpenWells Online Help was developed using WebHelp. WebHelp
features include: a table of contents, an index, a glossary, full-text
search, topic links, hypertext links to the internet and email, popup text,
and context-sensitive help. WebHelp will run on a variety of web
browsers and platforms.
Accessing Help
You can access this help file in either of the following ways:
• Follow the menu path, Help > OpenWells Help.
• Click the Help ( ) button located on the Toolbar.
• Press the F1 function key to access context-sensitive help.
• Click on the Help button in a dialog box.
Navigating the Help System
The WebHelp System can be navigated using the Table of Contents,
Index, and Search methods.
The help topics are also arranged in to mimic the books in the Table of
Contents. Using the browse buttons ( and ) the entire Help System
can be viewed in sequence as though browsing through a book by
turning the pages.
While navigating through the Help System you can return to pages you
have viewed by using the Browser’s Back and Forward buttons. These
buttons function in the same way they would function when navigating
through recently viewed pages on the Internet.
Using the Table of Contents
The Contents divides the help topics into open ( ) books, closed ( )
books, and pages ( ).
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To view the Contents, select the Contents button ( ) appearing
at the top of the WebHelp window. Click on a book to view the
associated chapters and pages contained within it. Click on a page to
view the topic in the HTML viewing area on the right.
Using the Index
To find information quickly on a specific help topic, select then Index
button ( ) appearing at the top of the browser WebHelp window.
A list of keywords will appear in the column on the left. Click on a
keyword to access the help topic or a menu of available help topics, or
enter a keyword in the search field provided.
Using the Search Function
To search the online help, click on the Search button ( )
appearing at the top of the WebHelp window. To perform a full-text
search enter search words in the Type in the word(s) to search for: field
and click Go.
Context-sensitive Help
Context-sensitive help displays information on demand about the active
component in the window. In OpenWells it can be accessed using one
of the following three methods:
• Click the Help button. Some dialog boxes contain a Help button,
which will display the Help topic for that specific dialog box.
• Press the F1 key. When an application component in the window
is active, press F1 to view the specific help topic for that
component. A link is available (View this topic in full WebHelp
mode.) at the top of a context-sensitive help page allowing you
to move into the full on-line help mode.
• Press Shift + F1 to access custom help (if available).
As an alternative, the Status Bar displays a brief description about an
active field in the OpenWells Data Entry Forms.
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Status Bar Help
The Status Bar Help Prompt (Field Description) is located in the lower
left corner of the OpenWells Data Entry Form window and provides a
one-line help prompt for the active field (the field in which the cursor is
currently located). This is the first place to look when you need help
understanding what to enter in a field. Additionally the status bar
displays the date range for the associated Event, name of the active unit
set, the System Datum, and the name of the current database.
Understanding Text Style within Online Help
When navigating through this online help here are some typographical
conventions to be aware of:
• Menu paths are documented in the following manner. A menu
path appears in bold with an arrow (>) separating each menu
level. For example, if you are instructed to select the Exit
command from File menu, it appears as File > Exit. If you are
instructed to select the Well command from the New submenu
in the File menu, it appears as File > New > Well.
• All field names appear in bold text.
• Keys on your keyboard that you are instructed to press appear in
bold (e.g., Esc). Keys that must be pressed in sequence are
connected by a plus (+) sign and appear in bold. For example:
Press Ctrl + F7 to access the Data Dictionary, Picklist tab.
• Buttons that appear on screen are documented in bold. For
example: Click OK.
• The term "click" is used when you should press the primary
mouse button. This button is the one used for most operations.
The term "right-click" is used when you should press the
secondary mouse button. This button is used for auxiliary
operations.
Using the Glossary
The Glossary contains definitions for acronyms and oil and gas related
terms used within the application.
Note:
If you do not see the Status Bar on your window, it may be turned off.
To turn the Status Bar Help Prompt back on, follow the menu path:
View > Status Bar. If there is no check next to Status Bar then it has
been turned off. Selecting it will turn it on again.
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To view a glossary definition, click the Glossary button ( )
in the WebHelp navigation bar and navigating through the list of
glossary items in the online help, or by clicking on a glossary hotspot.
Glossary hotspots appear within the help topic and are highlighted in
maroon. To view the Glossary item, click once on the underlined word.
A light yellow box containing the definition will appear. Press Enter to
remove the glossary box.
Printing a Help Topic
To print the currently open topic. Click on the Print button ( )
in the WebHelp navigation bar. The browser's print command will print
the entire WebHelp screen, including the navigation bar and the
currently viewable area of the open topic (i.e., a screenshot of the
browsers viewing area).
Creating and Using Favorites/Bookmarks in WebHelp
Favorites/Bookmarks can be a useful tool when you are learning how to
use OpenWells. Since WebHelp is displayed within a browser a user can
utilize the browser’s Add Favorites/Bookmarks feature to bookmark a
page that you may return to often.
To create a bookmark, use the following menu path while you are on the
page:
• In Internet Explorer follow the menu path: Favorites > Add to
Favorites.
• In Netscape Navigator follow the menu path: Bookmarks >
Add Bookmark.
• Enter the name of the topic in the field provided and click OK.
The topic title will then be placed under the Bookmark menu.
Help Videos
Some OpenWells topics contain a video link icon ( ). Select this icon
to view a procedural video.
Note:
The name of the Favorite/Bookmark link will always default to “OpenWells”,
ensure that the name is changed to match the topic being bookmarked.
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Navigating in OpenWells
In this chapter you will learn how to:
• Label the basic components of the OpenWells main screen.
• Navigate the OpenWells main screen in order to locate specific
data.
• Construct a full data set for the Drilling Tab of the Well Explorer
(Database, Company, Project, Site, Well, Wellbore, and Event).
• Construct a partial data set for the Contractors Tab of the Well
Explorer (Contractor, Rig, Rig Operation, Pump, and Shaker).
OpenWells Main Screen
The OpenWells main screen is made up of several components:
Labeled OpenWells Main Window
3
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Title Bar
This bar contains the name of the Application (OpenWells) and the
Minimize, Maximize, and Close Application buttons.
To move the application window to another part on the screen, drag the
title bar using the mouse.
To toggle the application frame between its maximized and restored
states, double-click the title bar.
The following table explains the use of the three buttons on the right side
of the Title Bar.
Function buttons in the Title Bar
Individual windows also have title bars. They behave much like the
application's title bar in that they contain similar menus and buttons. You
can use them to move the window to a different location on the screen.
Menubar
The Menubar is located at the top of the Application Window. It
contains commonly used commands.
The following menubar items are available in OpenWells Main
Application Window: File, Edit, View, Tools, and Help.
Button Function
Minimizes the application to the taskbar.
Toggles the application frame between
maximized and restored states.
Closes the application.
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File
The File menu in the OpenWells main menubar contains commands that
enable the user to create, open, print, preview, associate, and view
properties of data. This menu command also provides access to
Landmark’s Drilling Data Exchange utility (EDM Field Office Data
Transfer) to enable easy data exchange with other Engineer’s Desktop
applications in addition to third party applications.
There are twelve commands under the File menu; New, Open,
Associate, Save As, Send To, Data Exchange, import, Export, Print
Preview, Print Wizard, Properties, and Exit.
The following commands are reviewed in this manual; New, Associate,
and Print Preview.
For information on the other commands contained in the File menu of
the OpenWells Main Screen, refer to the application’s on-line Help.
New
The New command is found in the File menu of the Main Screen of
OpenWells is used to create a new data item.
The availability of data items in the New menu are dependent on the
active item in the Well Explorer tree. For example, if the Site node is
selected in the Well Explorer tree, then all nodes from the Well up in the
EDM hierarchy are available and new nodes of these kind can be
created.
The New command provides a submenu with several options. The
following table outlines the options for both tabs in the OpenWells main
window.
Figure 3.1: New command submenu options for the Drilling Tab
and Contractors Tab.
Drilling Tab Contractors Tab
Company Contractor
Project Rig
Site Rig Operation Anchor BOP
Well Anchor
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The New command can be used to create attachments. For more
information on attachments, see “Attachments in OpenWells” on page
3-94.
The New command can be used to create Lessons. For more information
on lessons,
Associate
The Associate command is used to link AFE Reports and Rig
Operations to Events.
AFE
The Associate > AFE command is used to link an Event to one or more
AFE reports. This will allow for the comparison of estimated costs
entered in the Cost Estimate & AFE report with the actual costs incurred
during Well Operations for the selected Event.
Wellbore BOP
Event Boiler
Completion Centrifuge
Report Degasser
Lesson Hydrocyclone
Attachment Motor
Pit
Pump
Shaker
Note:
In OpenWells an AFE may be associated to multiple Events which may exist in one
or more Wells.
Drilling Tab Contractors Tab
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To link an AFE report to an Event, select the Event in the Well Explorer.
Follow the menu path:
File > Associate > AFE...
The Associate Report Wizard appears.
Only AFE reports belonging to the current Project (see “Project” on
page 3-34) are available for selection.
Select the appropriate Wellbore and Event from the dropdown located
at the bottom of the wizard. The related AFE reports are displayed.
From the table select the AFE report to be linked to the current Event
and click Next.
Verify that the information selected is correct, enter a Description (this
field is optional), and click Finish.
The Event is automatically associated with the AFE and the selected
AFE report opens. The associated AFE appears in the Associated AFE
tab located in the Event Properties dialog, see “Event” on page 3-60.
Rig Operation
The Associate > Rig Operation command is used to link an Event to a
Rig Operation. This association links the phase of operations on a Well
(through the Event) to the Rig operating on the Well. This association
enables the Daily Operations Report to display Rig Equipment from the
correct Rig, allowing Operations records to be created for them. The
Shortcut Method:
As an alternative right-click on the Event and select Associate > AFE from the
menu that appears.
Note:
If any information selected is not correct, click Back to change the Report,
Wellbore, or Event selected. Click Cancel to cancel the operation.
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Event to Rig Operation association is also used to create a new default
datum and elevation using the Rig's default elevation.
To link a Rig Operation to an Event, select the Event and follow the
menu path:
File > Associate > Rig Operation...
The Associate Rig Operation to Event wizard appears.
The table displays Rig Operations that are currently associated with the
Event.
Select the appropriate Rig Contractor and Rig from the dropdown
picklist and click Next.
If the appropriate Rig Operation does not appear in the list select the
Create a new rig operation option.
Or
If the appropriate Rig Operation appears in the list select the Select a rig
operation option. Select a Rig Operation from the table to be linked to
the Event.
To create a new datum elevation for the well using the rig’s default
elevation, activate the Use rig operation's default datum checkbox. If
the selected rig has operated on the Well before the Rigs default datum
elevation may already have been created for that Well. For more
information on datums, see “Datum” on page 3-21.
Note:
A Rig Operation may be created for operations on multiple Wells, therefore a Rig
Operation may be linked to multiple Events.
Shortcut Method:
As an alternative, right-click the Event and select Associate > Rig Operation from
the menu that appears.
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